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READ ME FIRST 

Welcome to Take Control of Sharing Files in Leopard, version 1.0.  

This book helps you share documents among computers and over the 
Internet safely, using the file-sharing options available in Mac OS X 
10.5 Leopard. This book was written by Glenn Fleishman, edited by 
Tonya Engst, and published by TidBITS Publishing Inc. 

Copyright © 2007, Glenn Fleishman. All rights reserved. 

The price of this ebook is $10.If you want to share it with a friend, 
please do so as you would a physical book. Click here to give your 
friend a discount coupon. Discounted classroom copies are also 
available. 

We may offer free minor updates to this book. To read new infor-
mation or find out about any new versions of this book’s PDF, click 
the Check for Updates link on the cover. On the resulting Web page, 
you can also sign up to be notified about updates to the PDF via 
email. If you own only the print version of the book, contact us at  
tc-comments@tidbits.com to obtain the ebook. 

In reading this book, you may get stuck if you don’t know certain 
basic facts about Mac OS X or if you don’t understand Take Control 
syntax for things like working with menus or finding items in the 
Finder. Please note the following: 

• Menus: When I describe choosing a command from a menu in 
the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 
folder in the Finder is “File > New Folder.” 

• Finding preference panes: I sometimes refer to Mac OS X 
preferences that you may want to adjust. To change these system-
wide settings, open System Preferences by clicking its icon in the 
Dock or choosing System Preferences from the  menu. You 
access a particular preference pane by way of its icon, or the View 
menu. For example, to see “the Sharing preference pane,” you 
would launch System Preferences and then click the Sharing icon 
or choose View > Sharing.  
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• Path syntax: I occasionally use a path to show the location of a file 
or folder. Path text is formatted in bold type. For example, Leopard 
stores most utilities, such as Terminal, in the Utilities folder. The 
path to Terminal is: /Applications/Utilities/Terminal. 

The slash at the start of the path tells you to start from the root 
level of the disk. You will also encounter paths that begin with 
~ (tilde), which is a shortcut for any user’s home directory. For 
example, if a person with the user name glenn wants to install 
fonts that only he can access, he would install them in his 
~/Library/Fonts folder, which is just another way of writing 
/Users/glenn/Library/Fonts. 

What’s Really Different in This Edition 
In updating this book from Tiger to Leopard, I thought that I would 
make a number of changes along with new screen captures, and that 
was the case. What I didn’t expect is that Apple would fundamentally 
change and dramatically improve how it handled file sharing. 

That led to a large decrease in the page count of this edition, as 
workarounds to avoid roadblocks placed by Apple that took 1–10 
pages in the Panther and Tiger editions, and often involved editing 
text configuration files, could simply be removed. Even so, you’ll find 
this edition just as useful as the previous one. All the utility is still in 
the book—you should simply have less frustration in achieving the 
desired results. 

As one small example, in previous editions of the book, I had several 
pages that explained how to enable and control guest (password-free) 
access to AFP and Samba (Window style) file service. In this edition, 
there’s a brief entry on turning on file sharing for the default Guest 
account that’s new in Leopard and a look at how to enable or disable 
broad access to particular folders. 

Perversely, Apple did make it harder to modify settings manually for 
file services. Mac OS X now rewrites underlying configuration files 
based on settings you choose in the Leopard interface, overwriting 
any changes you make. In Tiger and earlier releases, configuration 
files were generally static, and you could edit those files to make 
changes. With Leopard’s new dynamic files, your options are fewer. 
As a result, this book focuses on changes you make through the Mac 
OS X interface instead of in underlying text files. 
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INTRODUCTION 

In the late 1980s, when only a few million academics and govern-
mental types had easy access to a very slow Internet and even most 
business users couldn’t afford pricey Ethernet gear, we hoi polloi had 
two ways to share files: sneakernet and snail mail. The algorithm for 
sneakernet was to insert a floppy disk, copy files to the floppy, eject 
the floppy, walk (in sneakers) across the room, insert the floppy, and 
copy files from the floppy. A little tedious, but it got the job done. 

For distances beyond the reach of sneakernet, the algorithm changed. 
Instead of walking across the room, you inserted the floppy in a 
padded envelope and walked it to the post office or called FedEx. 

Even today, sneakernet and snail mail are useful for transferring huge 
quantities of data—imagine the gigabits you can “transmit” when you 
send a bunch of hard drives by overnight mail or walk a DVD-R 
across a room—but most people share files through multiple accounts 
on the same computer, over local area networks comprised of wired 
Ethernet and wireless Wi-Fi links, or over the Internet using dial-up 
modems, broadband connections, and high-speed dedicated lines. 

In Take Control of Sharing Files in Leopard, I help you identify 
the right computer setup for exchanging files among users in your 
situation, with a particular emphasis on users working on networked 
computers. I focus on Mac OS X 10.5 Leopard as the hub of these 
activities, but the principles are the same on all platforms, and many 
specifics are identical or quite similar in Mac OS X 10.4 Tiger. 

I also explain how to connect to a Mac running Leopard from 
Windows XP and Vista and from Mac OS X 10.2 through 10.4.  

  
NOTE To keep this book focused on file sharing, we broke out two 

related topics into full-length titles of their own: 

• Take Control of Users & Accounts in Leopard examines setting 
up and managing users on a Mac running Leopard. 

• Take Control of Permissions in Leopard, expected to be 
available in 2008, has a more technical focus. 
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SHARING FILES QUICK START 

This book contains many details, not all of which may be relevant 
to your situation. You do not need to read every word before sharing 
files, but you should be familiar with the overall process first.  

Prepare to share files: 

• Before you think about the big world of sharing files on a network, 
you may wish to review techniques for sharing files among users 
on a single Macintosh. See Share Files on the Same Mac (p. 6). 

• Learn how file sharing is different from using disks to copy files 
from computer to computer or using email attachments to move 
files around. See What Is File Sharing? (p. 8). 

• Review reasons to share files, and see which match your situation. 
See Reasons for File Sharing (p. 11). 

• Decide on the hardware or online service that you’ll use as your file 
sharing server; see What You Need to Serve Files (p. 13). 

• Determine which file sharing method makes sense for your goals, 
budget, and expertise. Learn about Apple Filing Protocol, FTP, 
Pando, and others. See Decide on a File-Sharing Method (p. 19). 

• Take steps to manage security risks by becoming informed about 
what you expose when you share files over the Internet. See Avoid 
File-Sharing Risks (p. 32). 

Start sharing files: 

• Decide which folders and volumes to share, set up accounts for 
users, and choose their access privileges for viewing, storing, and 
modifying items. Learn about Apple Filing Protocol, Samba, FTP, 
and Web particulars for sharing files. See Share Files (p. 41). 

• Start sharing photos and music from iTunes and iPhoto; see Share 
Digital Media Files (p. 59). 

Access shared files: 

• Access shared files from Mac OS 9, Mac OS X, Windows XP, and 
Windows Vista. See Access Shared Files (p. 69). 
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SHARE FILES ON THE SAME MAC 

Although this book focuses on file sharing across a network, you can 
share files among users of the same Mac. In Leopard, not all users 
are created equally nor are all files meant to be equally accessible. 
Leopard purposely and appropriately restricts one user from viewing 
or modifying the contents of folders in another user’s directory. 

Users can exchange files on the same machine in one of three ways:  

• The Shared folder: Located in the Users folder on your startup 
disk, the Shared folder is set up so that all users who have physical 
access to the computer and an active account may read and write 
any files in the Shared folder; this includes the Guest account user, 
for whom all other files are deleted when they log out. Users can’t 
overwrite a file created by another user unless the default permis-
sions on the file are changed by either the file’s owner or an 
administrator. Using the Shared folder is the easiest method when 
you have just a few users, or all users need the same access. 

• Public folders: For a little more control, use the Public folder 
found in each user’s home directory. For instance, let’s say a 
home iMac has two accounts for two roommates: one for Bob and 
another for Stephanie. Of course, when Bob logs in to the machine, 
Stephanie’s files aren’t accessible through the Finder; Bob sees a 
locked icon on most folders within her home directory. Bob can, 
however, copy files into Stephanie’s Public folder’s Drop Box 
folder, and he can copy files out of her Public folder.  

• Shared volume: To avoid issues with permissions that crop 
up when using either the Shared folder or Public folders, you can 
instead use a separate volume as the repository for shared files, 
whether that volume is an internal or external fixed hard drive, 
a removable cartridge, or a second or subsequent disk partition 
on the boot drive. Starting in Leopard, volumes other than the 
startup disk are automatically set for all users to have full read 
and write access. 

This is a free sample of “Take Control of Sharing Files in Leopard.”
Click here to buy the full 89-page ebook for only $10!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU88625823085&PT=TRK-0049-SAMPLE


Page 8 

WHAT IS FILE SHARING? 

File sharing means storing a set of files on a fileserver, which could 
be a central computer or a network-attached storage device, and 
making it possible for any number of people to retrieve those files 
over any type of computer network, just as if those files were located 
on their own hard disks (Figure 1).  

FIGURE 1 

 

Many different 
machines can 
access a file 
server, whether 
they’re 
connected 
directly via 
Ethernet, over 
wireless AirPort 
(Wi-Fi), or via 
the Internet. 

   File sharing differs from emailing a file to a person or a group. When 
you email a document, the recipients are passive: they check their 
email routinely, and the document arrives. The burden of distribution 
falls on you.  

File sharing eliminates the necessity of pushing a file to others. You 
place the file on a server whenever you like, and all the people who 
need to retrieve it can do so whenever they like without coordination. 
The burden of distribution falls on the recipients, who choose the 
time and method by which they retrieve the file.  
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REASONS FOR FILE SHARING 

Now that you know the basics of what file sharing is and the 
advantages it offers, you can start taking control of sharing files by 
considering what you want to accomplish by sharing files, and with 
whom you need to exchanges files. In this section, I break out reasons 
for file sharing into a few large categories.  

  
NOTE Knowing what you want to accomplish may help you determine 

what hardware or bandwidth you need, covered in What You 
Need to Serve Files. Also, it may influence your choice of a file-
sharing technique, discussed in Decide on a File-Sharing 
Method. 

  

Coordinate Group Projects 
When you and at least one other person need to collaborate on a 
common set of files, you can set up a central location to store the files. 
Optionally, this central location can track whether a file has been 
checked out for use. 

  
NOTE Almost always, a file server helps reduce the time, cost, and 

effort needed for routine exchanges. For one-off exchanges, 
you might be better served by sending or receiving files via 
techniques not covered in this book, such as email, iChat file 
transfer, writable DVD, or USB memory drive.  

  

Create a Central Archive 
Many groups have a common set of files that grows over time, but 
these files are rarely changed once they are added. In this case, many 
people may need to add to the archive without needing permission to 
delete or re-organize files, while many of the same or an entirely dif-
ferent set of people may need access to read the archive. 

Avoid Relying on Email 
Even if you’re just trying to exchange one file with one other person, 
a file server can help you step around the problems of Internet email 
in the modern age. For instance, because of viruses and worms, many 
companies and some ISPs ban all or certain kinds of attachments, 
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WHAT YOU NEED TO SERVE FILES 

Once you have a clear idea of what you want to achieve with file 
sharing, it’s time to think about the hardware or hosting components 
necessary for file sharing. Any Mac running Jaguar through Leopard 
(or even older operating systems) can act as a file server; along with 
the server, you’ll need a network connection, and the faster the better. 
But you may be better off putting your files on a file-sharing network 
drive or on an Internet-based host. 

In this section, I first make recommendations for the best ways to 
set up a Macintosh or network drive as a file server. Then, I help you 
consider the best ways to network those devices to help any remote 
users access files via the Internet at a comfortable speed. After that, 
I look at Internet-based hosts that offer file-sharing services, since 
that option may be the best one for you. 

Macintosh on Your Network 
File sharing imposes little computational load on a computer: dozens 
of people could be transferring files actively on a Power Mac G4 from 
2002 or later that you’re simultaneously using as your primary work 
machine and you would hardly notice the effect on your work, 
assuming you had enough RAM.  

Here are some suggestions for maximizing a Mac’s performance as a 
file server: 

• Add more RAM: In the olden days—as recently as 2 years ago—
Macs appropriate for file serving came with inadequate amounts 
of RAM. Now, all desktop Macs come with 1 gigabyte (GB) of RAM. 
For best performance from an older machine, I recommend at 
least a gigabyte of RAM, or the Mac’s greatest possible amount 
of RAM if it can’t take a gigabyte. 

• Upgrade network switches and adapters: If you’re using a 
Macintosh sold in the last few years, it’s likely that the computer 
includes gigabit Ethernet (1,000 Mbps) support. You have at least 
100 Mbps Ethernet in any Mac sold in the last decade. Gigabit 
Ethernet switches, which create effectively a separate connection 
between any two connected computers, cost as little as $30. 
Upgrading an old 10/100 Mbps Ethernet hub to a 10/100/1,000 
Mbps Ethernet switch will dramatically increase speeds. 
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DECIDE ON A FILE-SHARING METHOD 

In this section I help you learn more about the file-sharing methods 
and determine the one that is most appropriate for your needs. You 
can divide networked file sharing into roughly four categories: 

• File services built into major operating system platforms, such as 
Mac OS and Windows. You can find more details abut file services 
in AFP, SMB or Samba, and NFS. 

• FTP (File Transfer Protocol), a universally supported method of 
exchanging files that dates back to the Internet’s earliest days.  

• Web downloads (and uploads!).  

• Proprietary methods that require a subscription or special client 
and server software not included with any operating system. 
Methods noted in this book are iDisk, Timbuktu Pro, and Pando. 

Table 1 presents a quick overview of these file-sharing methods. 

 
Table 1: Pros and Cons of File-Sharing Methods for Leopard Users 

Method Pros Cons 

AFP • Found on all Macs. 

• Free. 

• Works over Internet. 

• No longer any support for Windows 
access. 

SMB or 
Samba 

• Found on all Windows systems. 

• Supported under Mac OS X. 

• Best common method. 

• Free. 

• Some file name limitations 

• For security reasons, not well suited 
for Internet-based file sharing. 

FTP • Universally supported. 

• Plain, simple options. 

• Free. 

• Tracking files accurately by date 
modified and performing certain folder 
organizations is tricky or impossible. 

• Insecure in default setup of built-in 
server; strange firewall problems can 
occur.  

(continues) 
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AVOID FILE-SHARING RISKS 

Before you dig into the details of how to share your files, you should 
consider the risks of file sharing and possibly take action to avoid 
them. And, no, I’m not talking about storm troopers of the Recording 
Industry Association of America bursting into your bedroom—that’s 
only a concern if you’re using peer-to-peer file-sharing networks to 
share works that aren’t licensed for that kind of sharing. 

Rather, you risk having unintended others accessing your files or 
abusing your storage space. This can happen even if you share files 
only over your local network; unless you set up a firewall or other 
protection, you may unintentionally leave your files available to out-
siders. It can also happen if you don’t carefully protect your passwords 
while you work on insecure networks: your file servers could be 
hijacked using your own accounts. 

  
TIP The RIAA would like you to believe that sharing any music is 

illegal. Not so. Some music is licensed under broad terms that 
encourage sharing, such as forms of the Creative Commons 
license, a standard set of copyright terms designed to make it 
easy to retain rights while allowing reuse and distribution of any 
creative work. Some bands also explicitly allow trading of music 
recorded at live shows, or certain tracks they release online. 
See http://creativecommons.org/audio/ for more details.  

  

Problems with Open Servers 
Our Windows brethren have long been aware of the problem of 
accidentally running an open file server, because before Windows XP, 
Microsoft’s default configuration made it easy to turn on file sharing 
without any protection. On the first cable-modem networks, which 
work essentially like large Ethernet networks, people could troll 
through their neighbors’ unprotected files with abandon. Whoops. 

The Internet is so large and so fast, and full of so many jokers, that 
it has become something like a large local network. If you purposely 
or accidentally expose more than you intended, it’s likely that some 
automated evil—a scanning program that looks for open fileserver 
connections—will suck down your data. Less maliciously, however, 
because search engines like Google follow all links from public Web 
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SHARE FILES 

Turning on file sharing in Leopard requires only a few clicks in the 
Sharing preference pane. Although this section explains how to use 
the Sharing pane, you may wish to review the details about the service 
you are about to turn on first, either by flipping back to more general 
information in AFP, SMB or Samba, FTP, or Web, or by skipping 
ahead to more specific configuration details in Share with AFP, Share 
with Samba, Share with FTP and SFTP, and Share Files over the Web.  

Set Up File Sharing 
Leopard has streamlined file sharing by consolidating most of the 
services, and by improving its explanations. Three items in the 
Sharing pane’s Service list control the major file services: 

• File Sharing incorporates all three major forms of network file 
serving: AFP, FTP, and SMB.  

• Web Sharing turns on the local Web server. 

• Remote Login enables Secure FTP (SFTP) access, as well as its 
main function of remote Terminal sessions. 

 Other sharing options: Other options in the Service list aren’t 
related to file sharing, but rather refer to sharing computing power 
(Xgrid), remote management and operation, and handing out 
Internet access. 

  
An option not listed above, NFS (Network File System), requires 
additional configuration, but I find the method too dangerous 
to recommend to anyone who is not already an experienced system 
administrator. 

Turn on services 
Leopard makes it a snap to set up file sharing. It’s far easier in 
Leopard than in any version of Mac OS since, quite honestly, Mac 
OS 9! Leopard has more options and is more sophisticated, but the 
simplicity of sharing took 7 years to cycle back around. 
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SHARE DIGITAL MEDIA FILES 

Most of this book discusses sharing any type of files using file-sharing 
services. However, no book about sharing files on a Mac would be 
complete without explaining how to share iPhoto and iTunes 
libraries. 

Decide How to Share an iTunes Library 
The first step in sharing an iTunes Library is to decide whether to 
use the built-in iTunes Sharing feature or to use file sharing. I explain 
each option, next. 

Built-in iTunes Sharing feature 
iTunes has a built-in Sharing feature, which is easy to set up. You 
can use iTunes Sharing to share one iTunes Library among users on 
the same Mac or with users on a network. Unfortunately, the feature 
is limited in a number of ways:  

• Because Apple is playing nice with the recording industry, if 
another user connects to your shared library, all that user can 
do with shared media is play it from within iTunes. He can’t add 
a song or video or album to his own playlists, set ratings, or edit 
the tags that identify each MP3 file. That’s appropriate in some 
situations, but in cases where you’re sharing your own iTunes 
Library among your own Macs, such as on a home network, it’s 
needlessly limiting and technologically overrules U.S. law and 
court decisions on fair use. 

• Apple allows just five other users to connect to your iTunes Library 
within a 24-hour period. Boo, Apple, boo. This restriction prevents 
you from infringing on a song’s copyright, but in so doing elimi-
nates rights that you would have with physical media, like a CD, 
DVD, or VHS tape. If you have a large family or a number of com-
puters at work and home that you use to listen to an iTunes library, 
you aren’t violating anyone’s copyright and yet you could run into 
problems with this restriction. Listening to music isn’t the same as 
stealing music. 
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ACCESS SHARED FILES 

Now that you’ve had the chance to read about every conceivable way 
to share files, you can learn about the complementary action: acces-
sing those shared files. Let’s walk through mounting volumes or 
browsing for files on each of the major operating system versions, 
starting with Mac OS X. 

Access Shared Volumes with a Mac 
To mount a server from the Finder in Leopard, you can simply select 
it from the sidebar’s Shared list. New in Leopard, the Shared section 
of the sidebar shows all discoverable servers on the local network—
file servers that use Bonjour (all services shared by Macs) and 
NetBIOS (Samba on any platform) to announce their existence. 
After you select one of these servers, you can connect to it by clicking 
Connect As. Once mounted, connected servers are also shown in that 
list. See Mount by browsing for more details. 

  
TIP You can prevent shared and discoverable servers from appearing 

in the list: in the Finder choose Finder > Preferences, click the 
Sidebar button, and uncheck Connected Servers or Bonjour 
Computers. 

   

 Tiger & Panther: The following instructions for Leopard are 
nearly identical for Tiger (any version) and Panther (10.3.3 and 
later) except for the improvements in the network browser and the 
Sidebar listing.  

  
Alternately, to mount a server’s volumes, you can choose Go > 
Connect to Server (Command-K) to bring up the Connect to Server 
dialog. From that dialog, to access a server, you can: 

• Choose a recently mounted server: Click the top right button 
to pop up a menu to choose from. 

• Select a favorite server: Select a server from the list. 

• Browse for an AFP or Samba volume: Click the Browse 
button, and see Mount by browsing, a few pages later for more 
info. 
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DISMOUNT A SERVER 

Now that I’ve discussed mounting servers, it’s time to discuss dis-
mounting them. At some point, you will want to remove the server 
or servers sitting on your Desktop. Servers can slow your system if 
the network is slow or becomes unavailable. You may notice this on a 
Mac when a server window’s list of files tries to refresh and produces 
a spinning rainbow pointer. 

If you dismount servers before putting your computer to sleep, 
you can reduce delays at wake-up time when Mac OS X might try 
to search for those servers. However, when you shut down your com-
puter, Mac OS X automatically dismounts servers before powering 
off. You can also dismount a server from Leopard or Tiger by carrying 
out one of the following actions: 

• Drag the volume icon in the Desktop, and notice that the Trash 
icon on the Dock temporarily changes to an Eject button while you 
drag. Then, drop the icon on the Eject button. 

• Control-click the volume on the Desktop and choose Eject “Volume 
Name” from the contextual menu. 

• Select the volume and press Command-E. 

• Select the volume and choose File > Eject “Volume Name”. 

• In the sidebar, click the Eject button next to the server’s name to 
unmount all volumes associated with a server (Leopard only; the 
behavior of the Eject button and the sidebar is slightly different in 
Tiger).  

• Select the volume in any Finder window, and from the pop-up 
Action menu (it has a gear icon) at the top of the Finder window, 
choose Eject “Volume Name”. 

  
TIP If you don’t change your Finder preferences to display connected 

servers on the Desktop, you cannot dismount them using any 
method that requires selecting the volume on the Desktop. 
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APPENDIX A: SLEEP AND SHARING FILES 

In order to be reachable, any computer acting as a file server must 
be turned on and not in sleep mode. Although this seems obvious 
when stated this plainly, it can cause consternation if you use 
ordinary machines on your network as servers, as most of us do. 
Several readers of previous editions of this book wrote in with 
mysterious problems about servers disappearing, and reappearing 
later, which we tracked down to sleep options on the Energy Saver 
preference pane. 

In sleep mode on a Mac, the processor cycles down and the monitor 
switches to a low-power mode. When it’s asleep, the computer will 
respond to a key press or mouse click, but network access doesn’t 
automatically wake the machine.  

  
NOTE Macs can be woken out of sleep if they receive a “magic packet” 

over the network—like a sleeping prince receiving the kiss from 
the brave princess that wakes him. But this magic kiss has two 
parts: 

• First, you must open the Energy Saver preference pane, click 
the Options button, and check Wake for Ethernet Network 
Administrator Access.  

• Second, you need a way to send the magic packet from 
another Mac. Unfortunately, Apple doesn’t offer a way to 
have one Mac automatically wake another by trying to 
connect over the network to a shared volume. But you can 
do it manually—use the free Wake550 to wake up a sleeping 
remote server from another Mac (http://www.tc.umn.edu/ 
~olve0003/wake550.html). 

  
Follow these steps to turn off automatic sleep in Jaguar through 
Leopard: 

1. Open the Energy Saver preference pane, which displays the Sleep 
view. 

2. If you are using a laptop, choose Power Adapter from the Settings 
For pop-up menu. (In Mac OS X versions prior to Leopard, you 
may need to click Show Details first.) 
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